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Introduction 

Overview of the MiniMon Application 

MiniMon provides unattended, around the clock monitoring for fish 
marked with an ISO PIT Tag. MiniMon can collect data from 16 or more 
ISO transceivers simultaneously. The collected data is transformed into 
interrogation files which are partitioned by a specified time interval. 
MiniMon provides visual diagnostic information about the current 
interrogation process in addition to robust logging features. 

In addition to real-time interrogation, MiniMon supports the following 
features: 

• Remote interrogation 
• Automated data upload to PTAGIS 
• Tag report for data analysis 

System Requirements 

MiniMon runs on computers using the Microsoft Windows 98 SE, NT 4.0, Win2000 
or WinXP operating systems. Performance of the system is dependent on the 
speed of the machine and the amount of RAM memory installed. The minimum 
hardware requirements for MiniMon are as follows: 

• Processor Type: Pentium 
• Processor Clock Speed: 100 MHz 
• Memory: 32 Megabytes RAM 
• Hard Disk Space: 100 Megabytes free space 
• Operating System: Windows 95, 98, NT 4.0, Win2000 or WinXp 
• Monitor capable of 800 x 600 resolution or higher 
• 16550 UART standard serial port 

For optimal performance additional memory (64 Megabytes or greater), disk 
space (150 Megabytes), and greater processor speed (200 MHz or faster) are 
highly recommended, as is the use of a mouse or other pointing device. 
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To use the automated upload capability, you must have a modem or LAN internet 
connection. Also, Remote Access Services must be installed on the PC's network 
configuration. 

 

Supported Devices 

MiniMon supports two types of ISO transceiver devices: 

Destron-Fearing FS-1001 Stationary ISO Transceiver 

• Supports ASCII and BPA protocol. 
• Supports standard 5.x firmware versions for the following types of 

stationary readers: 
o FS1001 (Juvenile) 
o FS1001A (Adult) 
o FS1001M (Multiplexor) 

• Capable of 115k baud rate. 
• Provides a fiber optic/RS-232 Data port (BPA Protocol) and a RS-232 

maintenance port (ASCII). 
• Provides robust diagnostics. 

 

  

Destron-Fearing FS-2001 Portable ISO Transceiver 

• Supports standard 5.x firmware versions. 
• Capable of 56k baud rate. 
• With a firmware upgrade, supports Remote Interrogation without a PC. 
• Water resistent and portable. 
• DC power supply. 
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Firmware Upgrade 

Included in the installation of MiniMon are the firmware upgrades for both 
of the Destron transceivers. Also included is the VbFlash program to install 
the firmware. See the document "Instructions for using VbFlash" for more 
information. This information can be located in the 
"..\PTAGIS\MiniMon\Destron" subdirectory. 

 

Serial multiports extend the number of "native" COM ports available on the PC. 
The following serial multiports have been tested with MiniMon: 

RocketPort PCI Multiport Serial Cards 

Each RocketPort adds 4 to 32 "native" COM ports to your PC server or PC 
client using only a single PC slot - and no IRQs. The PCI models are 
recommended for NT/9x platforms. USB models will work with Win98, 
Win95b and Win2000 platforms. See www.rocketport.com for more 
information. 

 

Allen-Bradley SLC 5/03 Programmable Controller 

 

MiniMon supports Allen-Bradley SLC 5/03 programmable controller 
enabling/disabling transceivers with remote commands. See Device Settings for 
SLC 500 for more information on configuring this type of device. 
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 Serial GPS Devices 

MiniMon supports any serial GPS device that communicates with a standard 
NMEA-0183 protocol. See Device Settings for more information for configuring 
this type of device. 

 

Specification 

The following is the functional specification the MiniMon application was 
developed from: 

1. The end-product is built to be a throw away prototype. 
2. Needs to be small/simple/light-weight. 
3. Needs to be production robust by March, 2000. 
4. Needs to be able to read FS1001 or FS2001 transceivers. 
5. Needs to be able to read 'date/time' firmware or tagging firmware in 

FS2001 reader. 
6. Does NOT need master/slave redundancy. 
7. Needs to be able to read transceiver data from two comm ports on a PC. 
8. USB multi-plexing capability will be explored for two weeks. Based upon 

findings a decision will be made to incorporate mux capability into the 
throw away prototype. 

9. Insure that the mux delivers data in the proper sequence. 
10. Provide simple, two way communication between PC and transceiver 
11. Incorporate e-mail data submission capability. 
12. Open/Close current file manually. 
13. Stop data collection should be password protected. 
14. Run a stick tag report for tag analysis (outside program). 

 

 

Automatically Start MiniMon 

This topic describes how to configure MiniMon application to automatically start 
when the system reboots. This is useful for unattended installations. The 
following steps will create a special shortcut to the MiniMon.exe and place it in the 
system startup folder. 

To start the MiniMon program each time Windows starts: 

1. Click Start, and then point to Settings. 
2. Click Taskbar, and then click the Start Menu Programs tab. 
3. Click Add, and then click Browse. 
4. Locate the MiniMon.exe file in the installation directory, and then double-

click it. 
5. The MiniMon.exe file path will be displayed in the Command Line. Append 

the word AutoInterrogate to the end of the path: 
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 "C:\Program Files\PTAGIS\MiniMon\MiniMon.exe" 
AutoInterrogate 

6. Click Next, and then double-click the StartUp folder. 
7. Type the name that you want to see on the StartUp menu, and then click 

Finish. 
8. If Windows prompts you to choose an icon, click one, and then click 

Finish.  
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Configuring Devices in MiniMon 

To access the configuration settings for MiniMon, select the Configure button from 
the tool bar and the following window will appear: 

   

Pressing the OK button will save any changes made to the settings. MiniMon 
permits changes to the configuration during the interrogation process, however, 
the new settings will not take effect until after the next file change. Devices can 
also be configured using shortcut keys from the Device Status window. 

Click on the sections below for more detail on how to configure MiniMon: 

• Interrogation File 
• Logging 
• Devices 
• Security 

 

 

 

 

Interrogation File Settings 

To access the settings for the interrogation file, open the configuration dialog; the 
settings are located in the top section of the General tab page. 
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This section contains the following settings: 

• Site Code: a three character field that designates the site of 
interrogation. This code is used as a prefix for all interrogation files. 

• File Version Ext.: this is a single digit, 0-9, that can be optionally 
appended to the end of the interrogation file name. Use this feature to 
distinguish data files when multiple installations of MiniMon are used for 
redundancy. 

• Output Path: designates a location where all interrogation files will be 
stored. Click on the button to the right for browsing. Also, to create a new 
folder, type in the name at the end of the path and the application will 
prompt you to create the folder on exit. 

• File Generation Interval: Determines how often a new interrogation file 
will be created. It is a good idea to partition your interrogation data 
among several files. MiniMon automatically appends a unique file 
extension (A-ZZZ) for each file created. The range for the interval is 1 - 24 
hours. Note: MiniMon will create a new file at midnight if the interval 
spans this hour. 

• Synchronize on the hour: If this setting is checked, MiniMon will 
synchronize the file change to the closest hour interval. For example, if the 
current time is 10:45 AM, and the file generation interval is set for every 2 
hours, the next file change will be at scheduled at 12:00 PM if this setting 
is checked, otherwise, it would occur at 11:45 AM. 

• GPS/Time Stamp: this feature writes a generic comment message into 
the current interrogation file each time the specified time interval expires. 
This is a useful diagnostic tool to indicate normal operation for sites that 
don't collect much data. The range for the interval setting is 1 - 60 
minutes. Additionally, if a GPS Device is configured, the most current GPS 
coordinate will be inserted into the interrogation file whenever the time 
interval expires. 

• Append Milliseconds to tag records: if this option is selected, MiniMon 
will append the millisecond value of the time that a tag code was read 
from a reader onto a tag data record in an interrogation file. 

Log File Settings 

MiniMon contains robust logging capabilities for creating diagnostic information 
about connected devices and internal processes. Logging information is saved to 
a separate file from interrogation data, and is automatically partitioned by 
MiniMon based upon a fixed size constraint. The log file has a naming scheme of a 
'LOG' prefix, followed by the Julian date, followed by a unique partition identifier 
(A-ZZZ) and completed with text file extension i.e. LOG0047B.txt. 

To access the settings for the log file, open the configuration dialog; the settings 
are located at the bottom of the General tab page. 
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This section contains the following settings: 

• Log Mode - this setting has the following three options: 
o None: no logging will occur. 
o Summary: only essential information is logged to a file. This is the 

default setting and recommended for normal interrogation. 
o Verbose: detailed process information in addition to essential 

information is logged. Use this setting to help diagnose specific 
problems. 

• Log Path: designates a location where all log files will be stored. Click on 
the button to the right for browsing. Also, to create a new folder, type in a 
new name at the end of the path and the application will prompt you to 
create the folder on exit. 

Sometimes it's useful to be able to close the current log file and create a new 
one. To do this, select the Open Next Log File... (Ctrl-L) menu command located 
under the Edit menu heading. 

   

 

Configuring Devices 

To configure one or more devices to be used with MiniMon, from the configuration 
dialog, choose the Devices tab and the following dialog will appear: 
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From this dialog you can do the following: 

• Add a New Device - pressing the Add... button will display the dialog 
settings window to create a new device configuration. MiniMon can support 
up to sixteen or more devices for simultaneous interrogation. However, 
this number can be limited to the available system resources on the PC 
and the existing hardware. Each device corresponds to a specific serial 
port on the PC. 

• Remove an Existing Device - highlight an existing device configuration 
and press the Remove button. This will remove the device from MiniMon's 
configuration. 

• Change the properties of an existing device - highlight an existing 
device and press the Properties... button. This will display the device 
settings window to change the behavior of that device. 

Note - if MiniMon is presently interrogating, changes to the device will not occur 
until the interrogation file is changed. Devices can also be configured directly 
from the Device Status viewer using shortcut keys. 

See the device settings section for more detail on configuring devices. 

Device Settings 

This dialog is accessed from the Device Configuration when the user wants 
to add a new device or change the settings of an existing device. This 
dialog is also accessed via shortcut keys from the Device Status viewer. 
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Once the settings are complete, press the OK button to save these changes 
or press the Cancel button to disregard the changes. Pressing the 
Connect... button will launch a MiniTerm (terminal) window that will 
automatically connect to the device. This feature is not available for the 
BPA protocol. 

A device has the following settings: 

• Enabled: this determines if the device is enabled during the interrogation 
process. This is useful for situations where there are devices that are used 
temporarily - they can be disabled without losing their configuration. See 
Shortcut keys for doing this from the main window. 

• Type of Device: designates which supported transceiver or GPS device is 
connected to the serial port. 

• Port: designates which serial port the device is connected to. Only one 
device can be connected to a serial port at a time. MiniMon does not 
support a multiplexed configuration. 

• Baud Rate: this should match the baud rate setting on the device. This is 
the only configurable serial port setting for the supported transceivers 
devices since the other settings are fixed at N-8-1. The range of values for 
this setting are 2400-115200 baud. 

• Type of Filter: determines which data filter to use on the incoming data. 
This is dependant upon  the type device and other considerations outlined 
in the table below: 

Device Filter Use When 

FS1001 BPA Protocol Connected to COM2 high-speed port. 
This is a binary protocol. 

FS1001 ASCII Connected to COM1 maintenance port. 

FS1001A Adult BPA 
Protocol 

Connected to COM2 high-speed port of 
an Adult FS-1001A transceiver. This is 
a binary protocol. 

FS1001A Adult ASCII Connected to COM1 maintenance port 
of an Adult FS-1001A transceiver. 

FS-1001M ASCII SSR 
Mux 

Connected to COM1/COM2 ports of 
Small Stream Multiplexor reader. 
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FS-2001 ASCII 
w/TimeStamp 

Upgrade transceiver firmware 1.5 or 
ISO 3.8 and Time Tag setting is set to 
YES. 

FS-2001 ASCII 

 

Standard transceiver firmware 2.1; or 
timestamp firmware 1.5 or ISO 3.8 
and Time Tag setting is set to NO. 

Allen-
Bradley 
PLC  

SLC-500 
Protocol 

Connected to a SLC 5/03 PLC. 

GPS 
Device 

NMEA Connected to any serial GPS device 
that supports the NMEA-0183 
protocol. 

*400 kHz stationary transceiver is not shown 

• Default Xcvr ID: this correlates data and device within the interrogation 
file. Each Xcvr (transceiver) id should be unique and defaults to the serial 
port number.  

Important: The FS-1001 device overwrites this setting with an internal 
Xcvr ID which is transmitted in the BPA protocol data only. The internal 
device Xcvr ID and this setting should correspond to the same identifier. 

Device Settings for SLC 500 

SLC 500 is added and configured from Configuration Window. Open Configuration 
Window and click add:  

  

Add New Device Window will open. Choose SLC 500 device.  
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When SLC 500 device is chosen, button Connect will change to button Advanced. 

  

Advanced button will take you to the Advanced PLC Properties Window where 
you can add commands to be sent to all readers when the PLC state changes 
from Start to Stop. 
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Choose the state to which you want to assign commands from the drop-down list 
at the top. The list of commands on the right is the list of all commands available 
to be assigned to a state. The list on the left contains commands assigned to the 
current state. Add and remove commands using buttons at the center of the 
window.  

When finished, click OK and the program will take you back to the Add New 
Device Window. Click OK  to exit and save changes. 

PLC actions are logged to Logging Data tab of the Main Window. 

Terminal Window (MiniTerm) 

MiniMon contains an interactive terminal tool (MiniTerm) to connect to a device 
directly. This tool provides raw data from the connected device and contains a set 
of commands to perform remote configuration. This tool is accessed from the 
Device Settings dialog and does not support the BPA protocol. This tool can also 
be accessed from shortcut keys on the Device Status viewer. 
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Below outlines features of MiniTerm: 

Serial Port Settings 

Use this tool to override default serial port settings. When MiniTerm is launched it 
automatically connects to the device using the standard N-8-1 serial port settings 
and the selected baud rate and serial port from the Device Settings dialog. If it 
cannot connect to the device or garbage characters appear, most likely the baud 
rate or serial port settings are incorrect and need to be adjusted. The serial port 
settings can be configured without leaving MiniTerm by selecting this Port 
Settings... button from the tool bar. 

Terminal Window Settings 

Select the Terminal Settings button to change the dimension of the terminal 
window or change the font size and color. 

Commands 

Pressing this button on the tool bar will show/hide the commands list at the 
bottom of the terminal window. This list contains most commands for the given 
device type. Double-Click any command in the list and it will automatically be 
sent to the device. The same command can be manually typed into the terminal 
window, followed by a carriage return. 

Connect/Disconnect 
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Pressing this button on the tool bar will connect/disconnect the terminal to/from 
the device. 

Security 

MiniMon provides optional, high level security to protect against unauthorized 
access which can result in the loss of data. If a particular action is secured, the 
user is prompted to supply a correct password before continuing the operation. 

To access the security settings, choose the Security tab page from the 
configuration dialog. 

 

The following MiniMon actions can be secured: 

• Starting the Application: the user must supply a password to start the 
application. 

• Ending the Application: user must supply a password to close the 
application. 

• Closing an Interrogation File: user must supply a password to change 
the current file. 

• Configuring the Application: user must supply a password to access the 
configuration settings. 

To set the password, enter the same password in both boxes, to provide 
confirmation. This will change the password the next time a secured action is 
encountered by the user.  
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Interrogation Process 

Overview 

The interrogation process refers to when MiniMon is actively collecting data 
from the connected devices and translating it into an interrogation file. The 
user controls this process using the Start and Stop buttons located on the 
main window's button bar. When the process is stopped, no data is being 
collected. Once started, MiniMon connects to the configured devices, 
creates an interrogation file and begins collecting data. MiniMon keeps track 
of how long the current process has been running, and after the 
interrogation file interval expires, closes the current file and opens another. 
All data collected from the devices is written to the interrogation file, 
including status and timer tag information. 

Interrogation Status 

MiniMon provides real-time display of status information about the current 
interrogation process. There are three tab pages that display this 
information located on the main window: 

• Device Status - provides current information about each connected device 
• Interrogation Data - contains a subset of the current interrogation data 

collected from all devices. 
• Logging Data - contains a subset of logging information, regardless of the 

log mode setting. 

All of the above status information can be reset using the Clear Data menu 
command located under the View menu heading. 

Other Interrogation Utilities 

The following utilities are located on the button bar of MiniMon's main 
window. As with all buttons, they have an equivalent menu command. 

Next File - clicking this button will manually close the current 
interrogation file and open the next. This is useful to force configuration 
changes without stopping the interrogation process. MiniMon will reschedule 
the next automated file change. 

Insert Mark - clicking this button will insert a generic marker into the 
current interrogation file with the current date and time. The Data and Log 
status viewers will display a visual marker. This is useful for marking 
external events for analysis. 

Insert GPS Coordinate - (menu command only) this will insert a GPS 
coordinate into the interrogation file if a GPS device is properly configured. 

Device Status 
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MiniMon displays real-time status information about each device: 

 

 

The device status page contains the following information: 

• Device: type of device. 
• Port: the physical serial port the device is connected to on the PC. 
• XCVR ID: the transceiver id assigned in the device settings. 
• Status - the current state of the device which can contain three values: 

o Connected - collecting interrogation data. 
o Idle - interrogation process is not running. 
o Disabled - the user has disabled this device from collecting 

interrogation data. 
o Error - usually represents a communication error, see Last Alarm 

Exception below. 
• Tags: counts the number of tags read by this device. This value is reset 

when status information is cleared. 
• Last Alarm Exception - represents the last alarm exception sent from 

the particular device. If the exception is considered severe, the Status will 
be set to the Error state. 

• Global Information - in addition to status information about each device, 
global status information is displayed at the bottom of the page. This 
includes the status of the process (Idle or Interrogating), current 
interrogation file name, when the process was started, when the next file 
change is scheduled to take place, the logging mode and when the next 
data upload process is scheduled. 
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Shortcuts for Configuring Devices 

A right mouse click on any listed device in the status viewer will display a pop-up 
menu with shortcut commands. 

 

 

These shortcut commands can be invoked during an active interrogation process. 
Changes to the device configuration are made immediately, offering a more 
powerful alternative than having to wait for the next file change. The following 
describes each shortcut: 

• Enable/Disable: this will toggle a selected devices status from enabled 
(collecting data) to disabled (not collecting data). This is useful for 
collecting data from temporary installations without having to restart the 
interrogation process. 

• Clear: this will clear the status information for the selected device only. 
• Configure... this will invoke the Device Settings dialog for the 

selected devices. Changes to these settings take effect 
immediately during if there is an active interrogation process. 

• Terminal... this command will invoke the terminal window for the 
selected device. Warning, this will disable the device temporarily while the 
terminal window is active. Once the terminal window is closed, the device 
will begin collecting data again if it is enabled. 

Interrogation Data Status 

During the interrogation process, a subset of all interrogation data is displayed on 
the Interrogation Data tab page in chronological order. 
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Only the last one hundred lines or so of data are displayed. This status data can 
be cleared using the Clear Data menu command located under the View menu 
heading. This view can be locked by toggling the menu command Display 
Interrogation Data (Ctrl-I) located under the View menu heading. If the display is 
turned off, MiniMon is still capturing data to file, it's just not displaying it in the 
viewer. 

Clipboard 

If the interrogation process is not active, or the Display Interrogation Data is 
toggled off, selected rows of this data can be copied to the Window's Clipboard 
using the Copy (Ctrl-C) menu command located under the Edit menu heading. 

Logging Data Status 

During the interrogation process, a subset of all logging data is displayed within 
MiniMon's main window on the Logging Data tab page, in chronological order, and 
regardless of the log mode setting.
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This status display is limited to 100 lines of information. This status data can be 
cleared using the Clear Data menu command located under the View menu 
heading. 

 

Clipboard 

If the interrogation process is not running, selected rows of this data can be 
copied to the Window's Clipboard using the Copy (Ctrl-C) menu command located 
under the Edit menu heading. 

Interrogation File 

An interrogation file contains all data collected during the interrogation process. 
The format of this file is specified in the PIT Tag Specifications Document. 
Interrogation data is partitioned into several files for a given day based upon the 
file generation interval setting. The Output Path configuration setting determines 
the location of these files. 

Interrogation files have a naming scheme of a 3 character Site ID followed by the 
current Julian date and ending with a unique partition id extension (A-ZZZ), i.e. 
ABC00042.AA. An optional File Version Ext. can be configured to be appended to 
the file name to help manage redundant data collection sites. 

 

Remote Interrogation 
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What is Remote Interrogation? 

Remote interrogation means data is collected into a portable transceiver's internal 
buffer, then downloaded to a PC at a later time. The Portable FS-2001 
Transceiver has an optional firmware upgrade (FS-1001A 1.2 or ISO 3.8) that has 
a "Time Tag" setting which associates a date and time when a tag is detected. 
The detected tags and their timestamps can be stored in the transceiver's internal 
buffer for downloading into MiniMon at a later time using the Download Wizard. 

Configuring Remote Interrogation 

1. Install firmware upgrade on the Portable FS-2001 transceiver (Firmware 
version 1.5 or ISO). 

2. From a new or existing device configuration, connect to the transceiver 
using MiniTerm. 

3. Once connected via MiniTerm, verify the date and time setting on the 
portable transceiver using the "Display Current Date and Time" (DT) 
command. Note- the date and time format is dd-mm-yyyy hh:mm:ss 
- the day precedes the month. Date and time can be set using the "Set 
Current Date" (RD) and "Set Current Time" (RT) device commands. The 
date and time settings can also be changed directly from the transceiver 
menu. 

4. From the transceiver menu, set the "Time Tag" setting to "Yes", and verify 
the "Decimal Tag" setting is set to "No" and "Send to CommPort" is set to 
"Yes". Read a tag and you should see the date and time precede the tag 
code within MiniTerm. 

5. Create a new file on the transceiver using the "Close Current File" 
command. The program will prompt for an optional SiteID, UserID codes - 
these codes are written to the interrogation file for informational purposes 
only. 

6. The portable transceiver is now ready for remote interrogation. Once the 
remote interrogation has completed, use the Download Wizard to import 
the interrogation data into MiniMon. 

Note: The internal storage capacity of the portable FS-2001 transceiver is 6,400 
tags. 

Remote Commands 

Remote Command Window provides means for communication with a device 
while it is in interrogation mode. A command is sent to a device and device 
response, if any, is displayed in the Logging Data tab of the Main Window. 

Remote Command Window button is located on the right on the toolbar of the 
Main Window. It is also available from the Tools menu when device is connected. 
While available devices are idle, Remote Command Window button and the option 
of the Tools menu are disabled. 
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To connect devices, lick button Start. When the devices are connected, the button 
and the option on the menu are enabled. 
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To send a command, click on Commands button. Remote Commands Window will 
open. 

  

The following options are available on the Remote Commands Window:  

Select a Device. When a device is selected from the drop-down list, commands 
appropriate for the selected device are displayed in the commands list. 

Send to All Devices. Click the check-box to select Send to All Devices. This option 
allows you to send the command to all available devices. When the option is 
selected, the commands list displays intersection of commands of the available 
devices – commands common to all devices. 
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When a device or Send to All Devices option is selected and the list of available 
commands is displayed, select a command you want to send by clicking on it 
once, and click Send button. Alternatively, you can double click the command in 
the list. 

The command is sent to the selected device or to all available devices if Send to 
All Devices option is selected. If the command requires user input, Execute 
Device Command prompts you for the input. 
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The command and the device response to the command are displayed in the 
Logging Data tab of the Main Window. 

Download Wizard 

The Download Wizard provides step by step instructions for downloading a stored 
file from a portable FS-2001F transceiver operating in remote interrogation mode, 
or a FS-1001 SSR Mux reader. The result of the operation is a complete 
interrogation file containing tag codes with date and time of the detection from 
the stored file on the transceiver. 
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The Download Wizard prompts for the following information: 

• Device to Download From - must be a Portable FS-2001 transceiver 
with filter mode = 'ASCII w/ Timestamp'. 

• Begin and End date/time of interrogation - enter the date and time 
interrogation was started and stopped. 

• Which File to Download - the FS-2001 reader supports multiple storage 
files. There are two options: download all of the file or designate a single 
file number to download. 

• Interrogation File - provide a name and a location for the new 
interrogation file. 

• Append to this File - will append to the selected file instead of 
overwriting or creating it. If the selected file is an interrogation file, the 
FILE CLOSED interrogation file line is overwritten with the End Date time 
entered on the previous page; the original FILE CREATED date is not 
effected from this operation. 

Initiating the Download Process 

Once this information is complete, press the start button to create the 
interrogation file. The Download Wizard will time out after a short period of time if 
transceiver fails to respond. If the download was successful, a prompt will display 
the number of tags downloaded into the new interrogation file. Press the Close 
button to close the Download Wizard. 
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Upload Process 

Upload Process 

MiniMon has the optional capability to automatically transfer data files to the 
PTAGIS system using a modem or LAN TCP/IP connection. Once the data is 
successfully transfered to PTAGIS, it is then archived on the local PC. 

What you need to use this feature: 

• You must have a registered PTAGIS account to upload data. See details on 
the PTAGIS website for more information. 

• Your PC must be able to connect to the Internet - either through the LAN 
(Local Area Network) or a dial-up connection via modem to a local ISP 
(Internet Service Provider). 

To access the configuration settings for this utility, select the File Upload 
Settings... menu command located under the Tools menu heading. The following 
window will appear: 

 

The configuration for this utility is separated into three tab pages, detailed below: 

• General - describes where the data is, how to archive it and when to 
upload. 

• Connection - determines the connection type to use for the upload. 
• Diagnostics - useful tool for testing the current configuration 

settings. 

Overview of the Upload Process 

29 



MiniMon Help 

1. If the automated upload feature is enabled - the upload process is started 
when the designated interval has expired. The upload process can also be 
started manually by the user. 

2. If the PC is not connected directly to the Internet via LAN (Local Area 
Network) then a designated dial-up connection is launched. MiniMon will 
make several attempts to establish the dial-up connection. If the 
connection cannot be established (i.e. busy phone line) and the automated 
process is enabled, MiniMon will attempt the connection again when the 
next interval has expired. Any data that was not submitted in this aborted 
session will be submitted in the next upload. 

3. Once an Internet connection has been established, MiniMon will make a 
FTP (File Transfer Protocol) connection to the PTAGIS server using the 
designated user account settings. You must have a registered account with 
PTAGIS to upload data. 

4. Once the FTP connection is established, MiniMon will compress all the data 
files into a single file and attempt to transfer the compressed file to a 
STAGE subdirectory under the user account's home directory on PTAGIS; 
the STAGE will be created if it does not already exist. 

5. Once the compressed data file has been completely transferred, PTAGIS 
will automatically detect the file and begin distributing the compressed 
data files for loading. 

6. PTAGIS will respond with an acknowledgement file which contains the 
status line that describes if the distribution process was successful or not. 

7. If the process was started automatically, the results of the submission can 
be viewed in the log file. If the process was started manually, results are 
displayed both in the upload window and in the log file. 

General Upload Configuration 

The General tab page contains information about where the data is to be 
uploaded, where and how to archive the data and when to upload this 
information. To access this dialog, run the File Upload Settings... command from 
the Tools menu heading. 
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Each section on the General page of this dialog is described below. 

Data Section: 

• Data Path - contains the path where MiniMon interrogation process is 
storing the data files. The value should always match the Output Path 
setting in the General Device Configuration settings for normal operation. 

• Temp Path - contains the path used by MiniMon for storing temporary 
files during the upload process. 

• Archive Path - contains the path where MiniMon will archive data files 
after they've been successfully uploaded to PTAGIS. 

• Simple Archive - if this option is set, after the transfer has completed, 
the data files will be moved from the Data Path to the Archive path. This 
option is recommended if the number of data files for a given installation 
is relatively small. 

• Structured Archive - if this option is set, a subdirectory will be created 
for each day an interrogation has taken place. This directory will be 
identified by the site code and a julian date. Once the data files have been 
transferred, the data files will be copied to their corresponding directory 
matching the 8 character file name. This option is recommended for 
installations that produce a large number of data files. 

• Compress Archive - if this feature is checked, when the data files are 
moved to the archive, they will be compressed to a common file matching 
the 8 character file name (site code + julian date). The compressed file is 
PKZIP compatible. This feature significantly reduces the amount of hard 
disk space needed for the archive and is recommended for unattendend 
installations. 

Upload Section: 
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• Manual Upload Only - if this option is set, data will not be automatically 
uploaded on a periodic basis. It will be up to the user to execute a manual 
upload to transfer data to PTAGIS. 

• Automated Upload - if this option is set, data will be automatically 
uploaded to PTAGIS on a periodic basis. The interval is determined by the 
hour setting. If the Synchronize on Hour feature is checked, the interval 
will round up or down to the nearest hour. The Synchronize Delay period 
will add an additional number of seconds before the launching the upload 
process. This is useful for synchronizing with the interrogation generation 
period so that data will be transferred to PTAGIS as soon as it's available. 
The next schedule upload is displayed on the Device Status viewer. 

• Save Acknowledgement File - if this feature is checked, the 
acknowledgement file returned by PTAGIS on a successful or unsuccessful 
transfer will be saved in the Temp path. This feature is useful for 
troubleshooting the upload process; it's recommended to leave this 
feature off for normal operation. 

   

Configuring a Connection for Upload Process 

In order to submit data files to PTAGIS, a connection to the Internet and the 
PTAGIS server must be established. This topic describes the various settings used 
to establish this connection. 

To access this dialog, run the File Upload Settings... command from the Tools 
menu heading, then choose the Connection Tab page. 

 

 

Each section of this dialog is described below. 
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Connection Section - this section describes how MiniMon will connect to 
the internet. 

• Use Local Area Network (LAN): If you PC is already connected to the 
Internet through your network, choose this option. 

• Use Dial-up Connection: If you connect to the Internet using a modem 
and a dial-up connection use this option. Select the appropriate 
phonebook entry to establish this connection. If you do not have any 
phonebook entries - see Windows help to create one. The Refresh button 
will refresh the drop-down list of phonebook entries. In order to use this 
feature, you must Remote Access Services (RAS) installed; see your 
network settings for more information. 

• Redial Attempts: this setting designates the maximum number of 
attempts to establish a dial-up connection. If MiniMon is unable to 
establish a dial-up connection after N attempts, it will abort the current 
upload process. If the automated upload feature is enabled, MiniMon will 
attempt to establish the connection again when the next interval expires. 

• FTP Action Time out: this setting, in seconds, determines how long an 
FTP client connection should wait for the FTP server to respond. If zero is 
used, this feature is disabled and the system default value is used instead 
(typically it is 15 minutes). 

• FTP Passive Mode: use this setting only if the network is constrained to 
allow only FTP to operate in 'passive mode'.  

 

PTAGIS Section - this section designates the PTAGIS user account to use 
for establishing a connection to PTAGIS. You must have a valid PTAGIS 
user account to upload data. 

• User Name: the user name for a PTAGIS account. The name is case 
sensitive.  

NOTE: due to security issue, MiniMon requires users to contact PTAGIS to 
get the name of this account for submitting data.  

• Password: the password associated with the PTAGIS account. 
• Remote Server: the server name or IP address for the PTAGIS FTP 

server. Set Defaults button will default this field to 'ftp.ptagis.org'. 

Upload Diagnostics 

The Diagnostics for Upload Settings will submit a test file to PTAGIS. This is useful 
for testing the current configuration settings and troubleshooting problems. The 
test process will display detail information for each step in the process. 

To access this dialog, run the File Upload Settings... command from the Tools 
menu heading, then choose the Diagnostics Tab page. 
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To start a test upload process, press the Test button and the rest is automatic. 
The Status viewer will display detail information for each step of the process. Use 
the Stop button to cancel the process at anytime. There are certain points in the 
upload process that cannot be stopped; a message will appear in this situation. 
Also, you cannot close this dialog while an upload process is active. Use the Clear 
button to clear the messages from the status viewer. 

The Ping button will use a standard network utility to verify the Remote Server 
setting is pointing to a valid host. The Winsock button will display the version of 
the winsock library for diagnostic purposes. 

Manual Upload Process 

At anytime, the upload process can be run manually from MiniMon's main 
window, even if there is an automated upload scheduled. An active interrogation 
process will function normally during an upload process. You must configure the 
upload settings before running this process. Each step of the process is displayed 
to the screen and written to the log file. 

To start a manual upload process, choose the Manual Upload... command located 
under the Tools menu. The following dialog will appear: 
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This dialog contains options for the upload process. Each option is described 
below: 

• Upload and Archive: this option will upload the data files to PTAGIS and 
then archive them according to the archive settings. 

• Archive Only: this option will only archive the data files. No data will be 
uploaded to PTAGIS. 

• Delay Upload: the upload process will delay for the configured number of 
seconds. This feature is useful if you are connected remotely to the PC and 
need to log out to allow the process to continue. 

• Close Dialog when Upload Completes: this feature will close the 
window upon completion of the upload process. This is useful when the 
process is unattended. 

Below the options is a list of data files corresponding with the Data Path setting 
from the General Upload configuration. Only the selected data files will be 
processed. If no data files are selected, or none exist, the Start... button will be 
disabled. Use the ctrl/shift keys to select multiple files. 

Pressing the Start... button will launch the upload/archive process and the 
following window is displayed: 
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The overall staus of each step of the process is displayed. Use the Hide/Show 
Detail button to toggle the detail view of processing status. Use the Cancel 
button to stop the process. There are certain steps in the process that will not 
cancel immediately. Please wait patiently and the process will eventually stop. 

The Close Window on Completion feature will automatically close the window 
when the process has completed (successfully or not). This is useful when the 
process is left unattended. 
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Other Features 

Tag Data Report 

The tag data report provides detail information about how many times a 
particular tag was deteced on a particular device. This information is useful for 
testing operation of the physical transciever device. 

To access this report, select the Tag Report... menu command located under the 
Tools menu heading. 

 

Pressing the Run button will execute the report based upon the current 
configuration and display the results in the viewer. The Save... button will 
prompt to save the contents of the report to a file. 

To change the report settings, select the configuration tab and the following will 
appear: 
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Below lists each setting for a Tag Report: 

• Use Current File: if this option is set, the current interrogation file will be 
used as a data source for the report. This option is only available if the 
interrogation process is active. 

• Select (File): use this option to select an existing data file as a data 
source for the report. 

• Filter for TAGS: if this feature is selected, only the listed tag codes will 
be tallied in the report. This is useful for identifying stick tag detections. 
Use the Add Tag... button to manually enter each tag code, or Import 
Tags... button to import an existing file of tag codes into the list. If this 
option is not selected then all tags will be tallied for each device. 

• Filter for DEVICES - if this feature is selected, only the selected devices 
will be displayed in the report. 

• Filter for Interrogations After - if this option is selected, only 
detections after the designated time will be counted in the reports. This is 
useful for identifying separate stick tag events within the same data file.  

System Information 

System Information window provides a snapshot of detail summary about the 
current interrogation process and system resources. Use the Refresh button to 
get the most current information. 
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This window is comprised of two sections: 

MiniMon Process Information 

• Started On: the date and time the current interrogation process was 
started. 

• Created: number of interrogation files created since process was started. 
• Current File: name of the current interrogation file that is open (the 

actual physical file will have a tmp extension appended to the file name 
until it is closed). 

• Next Change: when the next scheduled file change will occur. 
• Logging: which log mode setting is in use. 
• Log File: the physical file name and path used for logging to. 
• Log File Size: number of lines written to the active log file. 

* Some of the above information is displayed in real-time on the Device 
Status summary. 

System Information 
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System information section contains a snapshot of generic system resource 
information, such as physical memory, virtual memory and disk space usage. To 
see more detail on this information, click the Detail... button.  
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